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Getting Started
You are now ready to start creating your accounts
structure in Bottom Line.  You can do this in one of two
ways…

• You can use one of the pre-supplied sets of accounts
as a template which can then be modified to suit
your requirements.

• If none of the existing templates provide a close
match, you can start with a blank document and
build your accounts structure from scratch.

Whichever of these two routes you choose, follow the
steps in this chapter to set up Bottom Line in prepara-
tion for Chapter 4 and the actual process of building
your accounts structure.

Installing Bottom Line

Before doing anything else, you should copy Bottom
Line and the relevant ancillary files onto your Macin-
tosh hard disk.

Turn to the accompanying booklet — Installing Bot-
tom Line — to find out how to do this.

Opening Bottom Line

Once installed, you are now ready to run the Bottom
Line application…

Double click the Bottom Line icon to open the
application.

From the Macintosh desktop, locate the
folder containing Bottom Line then open it
by double clicking the folder icon.
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Personalise your copy

On opening Bottom Line for the first
time, you are invited to personalise your
copy of the program by entering your
name and the name of your organisa-
tion.

Type your name then click inside the Organisation box (or press the Tab
key) and type the name of your organisation.

On completion, click OK to accept these details.

Bear in mind that these details are destined to become a permanent
feature of the opening title screen — so, if you spot a typing error, click
inside the relevant box and edit the text in the usual Macintosh way
before clicking OK.
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Creating a Bottom Line document
You will now see the Bottom Line menu from which
you can create a new accounts document or open a pre-
supplied template…

Bottom Line menu bar

Creating a New Set of Ac-
counts

If you intend to start building
your accounts structure from
scratch then create a new ac-
counts document by choosing
New from the file menu.

Alternatively…

Opening an Accounts
Template

To save valuable time and effort, Bottom Line provides
a number of pre-prepared account structures which you
can customise to meet your requirements.  If you want
to use one of these templates, choose Open from the
File menu…

To open an existing template,
choose Open from the File menu
then locate and open the
required document from the
directory list in the usual Mac
fashion…

Taking the short cut…

You can also open an existing
data file from the Macintosh

desktop by double clicking its icon.
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A New Business
Before you can start using your accounts document,
Bottom Line needs to establish the following
information which appears on all relevant customer and
supplier paperwork — such as invoices, statements and
remittance notes.  To complete these entries…

More about passwords

• If security is not a problem, leave the password
blank to allow free access.

• For increased security, you may want to change
your password at regular intervals.

• If you should forget your password, contact the
Forecast Systems hot line for assistance.

VAT Number:  If applicable,
enter your VAT registration
number.

Business Name:  Enter the name of your business
exactly how you want it to appear on all printed reports.

Business Address:  Type your business address in the
four lines provided.

Telephone Numbers:  Enter your business telephone
and fax numbers.

Password:  If you want to restrict access to your data,
specify a password.  To help keep your password
private, each time you open this document, you will be
expected to enter the password exactly as it is
registered now — including capitals and lower case
characters.
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Start date for Year:
Enter the date which
represents the start
date of your financial
year.  The date must
be the start of the
financial year in which
the current period
occurs — see note
overleaf.

Edit the preset date in
the usual Macintosh
fashion.

Setting up the Business Details

Turn the page for further information about the Current
Period…

Dates

The current date is preset to your Macin-
tosh’s system date.  If this is incorrect, select

Control Panels from the Apple Menu then reset the
date (and time) in the Date and Time panel.  Turn to
your Macintosh User’s Guide for further details.

Turn to Chapter 19 to see how dates are entered.

Click OK to accept the new
business details.

Number of Periods:  The financial year can be divided
into either 12 or 13 accounting periods.  This option is
preset to 12 monthly periods — if you want to prepare
your accounts every 4 weeks, click the button for 13
periods.

Current Period:  This is where
you enter the accounting period
from which the accounts are to
start.  If you are starting a new
financial year then you would
enter period 1.  However!  If you
are transferring your accounts
part way through your financial
year, we recommend that you
overlap the initial accounting
period in Bottom Line with the
period that has just ended in
your existing books as illustrated
in the example overleaf…
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Start of  Year and Current Period

Imagine that you are keeping a manual
set of accounts and that you decide to
switch to Bottom Line at the end of your

financial year.  If your financial year finished on
31st December 1995 then you would start from
period 1 in the new financial year which, in turn, has
a start date of 1st January 1996…

Now imagine that you want to switch to Bottom
Line in January 1996 but, this time, you are already
part way through your current financial year —
which started on the 1st October 1995.  In these
circumstances, you would close your old books at
the end of period 3 and start Bottom Line from the
same period — period 3.  The overlap allows you to
transfer the existing accounts, balance them and close
the period before Bottom Line takes the strain in period 4.
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Saving  Your Business Details

Check the details you have just entered, paying special
attention to the last three options — Start of the Year,
No. of Periods and Current Period — which cannot be
modified once saved.

When you are ready, click OK to accept these details.

You will now see the following dialog…

Changing business details

Once you have
finished setting

up your new accounts
document, you can modify
the business details and
password by choosing
Business Details from the
Special menu.

For more information, turn to Chapter 19.

Re-enter your password (if applicable) then click OK to
proceed…

Un-accepted password

If you make any typographical errors when
confirming your password, Bottom Line

will complain.  When prompted to confirm your
password for a second time, either re-enter the char-
acters correctly — or, if you want to change the
original password, click Cancel to return to New
Business Panel.

If you are working with a template, turn now to the
section “Introducing the Bottom Line desktop” later in
this chapter, otherwise turn the page…



Chapter 3 - 9

Setting up Bottom Line

New Accounts Set Up
If you are creating a brand new accounts document,
Bottom Line needs to know your numeric ranges for the
five account categories — Assets, Liabilities, Capital,
Revenue and Expenditure.

The program displays the Accounts Set up panel…

Working from the accounts structure that you designed
earlier, complete the following details…

Account templates

If you are working with a pre-supplied template, the account details have already been entered for you.
On completing the set-up routine, choose General Account Details from the General Menu to check

and, if necessary, modify the options as described here.

Account Ranges: As described in Chapter 2, Bottom
Line provides five file dividers — or account categories.
These organise and store all the accounts required to
generate the Balance Sheet and Profit & Loss reports.
Each account is linked to the relevant account category
via its five digit code.

To determine which account items are assigned to
which category, you can retain the preset values or
enter the revised starting numbers that you have de-
vised for each of the five account categories — Assets,
Liabilities, Capital, Revenue and Expenditure.

Capital Accounts: Next, enter the codes for the two
Capital accounts which you will assign to the current
and retained profits on the Balance Sheet. (see further
details on the next page)
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Expenditure

Capital

Revenue

Liabilities

Assets

10000

20000

40000

50000

60000
60000

Balance

Account

99999

50000

Balance

Account

59999

40000

Balance

Account

49999

20000

Balance

Account

39999

10000

Balance

Account

19999

Account ranges in action

Using the code ranges shown above,
all accounts assigned a number

ranging from 10000 to 19999 will line up
within the Assets account category, while those
assigned numbers between 20000 and 39999
will be organised under Liabilities  and so on.

Profits, past and present

To recap from Chapter 2…

The Retained Profits account records the
profits accumulated during previous years.

The Profit & Loss account reflects the accumu-
lated profit for the current year.

New Accounts Setup (continued)
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New Accounts Setup (continued)

Suspense Accounts: Although the program does
everything it can to prevent this, an unusual situation
could arise when transactions from the Sales or Pur-
chase Ledgers are posted — via an analysis code — to
a General Ledger account which does not exist.

To overcome this problem, your accounts structure
should include the relevant Suspense accounts to
catch any itinerant postings.

To capture stray postings from the Purchase Ledger,
enter the number (of an asset) that you are assigning
as the Debit Suspense account.

Enter a liability account number to act as a Credit
Suspense account.

Journal Numbers: In Chapter 15, you will be meeting
the Journal facility which is used to enter direct transac-
tions to the General Ledger.

For auditing purposes, Bottom Line automatically
numbers each journal for you — starting from 1.  If you
want to start from a different number, edit the preset
number in the usual way.

Check the information you have entered and if neces-
sary, make any corrections.  Once everything is the way
you want it, click OK to accept these details.

Bottom Line now creates your ledgers.
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Making Changes

Once the set up routine has been completed, you can modify
this information by choosing General Account Details from the General
menu.  Turn the page to find out how you can access the General menu.

Bear in mind that any major changes — for example, renumbering the
account code ranges — should be made before you add or modify
account items to avoid undermining a framework which is firmly
established.

New Accounts Setup (continued)
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Introducing the Bottom Line Desktop
Having set up your
accounts, you will now
see the Bottom Line
Desktop…

Notice that the desktop is divided into three separate
areas — Sales, General Ledger and Purchases.

Notice also that each area, in turn, contains four icons.

Like the Macintosh desktop, Bottom Line icons act as
containers which you use to enter, organise and store
your work.  Icons also provide the main access route
into Bottom Line — for example…
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Selecting a Ledger

During the course of your work, you will constantly
need to switch from one ledger to another.  In Bottom
Line, this is done by selecting the relevant ledger icon.

When you select a ledger, two additional menu names
appear in the menu bar.  These two menus contain those
commands which are unique to the chosen ledger — try
selecting each ledger in turn and examine their associ-
ated menus for yourself.

Click the relevant ledger icon to select it…

…and to access the menu items unique to
that ledger.
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Opening a Ledger
In addition to selecting a ledger icon, you can
open it to view its contents.  We will be looking
at the Sales and Purchase Ledgers later in this
manual — so, for now let’s concentrate on the
General Ledger.

As explained earlier, the General Ledger con-
tains the five account categories that will be

used to organise and store all your account
items.  To help you get your bearings, open
the General Ledger then open any account
category as illustrated here…

Double click the
General Ledger
icon to open its
window…

Double click an
account category icon
to open its window…

This window would
contain a list of Assets if
you are working with an

account template
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Viewing Windows

Notice that the contents of each opened icon are displayed in a window.  If you are working with an accounts
template, you will now see all the account items which have already been assigned to that category.  By contrast, if
you have created a new accounts document, the account category window will be empty in readiness for the new
accounts to be entered.

You’ve guessed it — each account can be opened by double clicking it.  However, before you explore any further,
take a quick look at the behaviour of windows…

Viewing account items

The account items assigned to each
Account Category can be viewed in one

of two ways — as icons (right) or as a hierarchical
list (below).

To switch from one mode to another, choose the
relevant option — By Icon or By Name — from
the View menu.
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Manipulating Windows
All icons on the Bottom Line desktop can be opened in
the same way as the General Ledger — and it is possi-
ble to have more than one window open at once.

Each open window has, in turn, a number of features
which help you view its contents.  For example, you can
re-size a window or scroll to reveal contents which may
be hidden.  You can also move, arrange or close other
windows that may be obscuring your view.

The Active Window

Before you can work with a window you need to ensure
that it is the active window.  To do this, click anywhere
inside the required window to bring it to the foreground.
You can tell which window is active because its title bar
is highlighted by horizontal stripes.

You can also bring any open window to the front by
choosing its name from the Window menu.

Rearranging Windows

There may be times when you want to view the contents
of several windows at the same time.

In these circumstances, Bottom Line provides two
options which help you to organise and arrange all the
open windows on the screen.

The Title Windows command
re-sizes all the open windows
and arranges them around the
screen.

Alternatively, the Stack Win-
dows command re-sizes and
layers all open windows so that
each title bar is visible.
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Locating a window’s ‘parents’

As with the Macintosh Finder, windows can be nested inside other windows in a hierarchical fashion — you can
open a window containing icons which open other windows, and so on.

While you have an active window, you can locate and open the window from which it was opened — or other
windows further up the hierarchy.  To do this…

Click the Window name in the
centre of the header while holding
down the Command Key.

Choose the required window
from the pop-up menu.

Returning Home

Whenever you want to return to the Bottom
Line Desktop Window…

either choose the account file name from the Win-
dow menu,

or press H, for home (press the H key while hold-
ing down the Command key).
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Manipulating a Window
Click the close box to put the window away.

Click and drag the title bar to move the window to a new location.

Click the zoom box to expand the window to its
optimum size.  Click again to restore the window
to its previous size.

Drag the vertical scroll box to
scroll anywhere in the vertical
direction.

Click the vertical scroll bar
(where it is grey) to scroll one
window’s depth.

Click the scroll arrow to scroll
in the direction of that arrow
(hold down the mouse button
to scroll continuously).

Click and drag the size box in any direction to change
the window’s height and/or width.

Click the horizontal scroll bar (when it is grey) to scroll one window’s width.

Click and drag the horizontal scroll box to scroll anywhere in the horizontal direction.

Some
windows
have
control
buttons in
the lower left
corner.

Closing the
desktop window

If you click the
close box on the Bottom
Line desktop, this closes
your accounts document.
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Preset Rate : The VAT code that you
select here automatically appears
on all invoices and credit notes —
you can overwrite the preset VAT
code when preparing each invoice
or credit note.  Click the button for
the most commonly used VAT rate
and to avoid confusion, ensure that
the rate
you select
has a
Title.

VAT Rates
If you are VAT registered, this section de-
scribes how to specify the VAT rates charged
on your sales and purchases.  To do this,
open the VAT Details panel like this…

Bottom Line provides six different VAT rates
— coded from 0-5.  These codes are used as
a convenient form of shorthand to apply the
correct VAT percentage to each itemised sale
or purchase.  You will probably use 0 for
Zero rated and 1 for Standard Rate — other
rates may be added as required.

Referring to our example, enter each VAT
rate like this…

Choose the VAT
Details option
from the Special
menu to display
the following
panel…

VAT Rate Description:
Enter a suitable descrip-
tion for each VAT rate.

VAT Rates: Enter
the VAT percentage
to be charged for
each rate.
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VAT Rates (continued)

Cash Accounting for VAT: Normally VAT is accounted
for at the point when each supply is made and each
sales or purchase invoice  is raised (the tax point date).

When you open the VAT Details panel for a new set of
accounts, normal VAT accounting is assumed and the
Cash Accounting option is de-selected.

If you are operating a Cash Accounting scheme click
this check box so that a cross appears Bottom Line
then accounts for VAT at the point when each pur-
chase payment  or sales receipt has been entered
and allocated. …

…otherwise leave the check box deselected for normal
VAT calculation.

Refer to your VAT literature to establish whether or not
you may use Cash Accounting.
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Changing VAT rates

You can re-open the VAT Details panel any
time you need to set a new VAT rate or

amend an existing VAT percentage.  These changes
will be immediately applied to all subsequent sales
and purchase transactions.

Print EC Sales List annually:  If you export goods to
other member states in the European Community (EC),
you are required to produce an EC Sales list.

Normally, an EC Sales list is submitted every calendar
quarter (to 31 March, 30 June, 30 September, 31
December).  However, if you have dispensation from
Customs and Excise to produce an EC Sales list once
a year then click this option to select it.

Once everything is the way you want it,
click OK to accept the information.

VAT Rates (continued)

Preset to EC Sales Goods:   As explained above, the
EC Sales List is required for goods exported to EC
countries - but not services.  It is therefore necessary
for you to identify for every sale whether the sale is for
goods (as opposed to services).

In Chapter 6 you have the option to select whether a
particular supply is for Goods or Services but if you
tend to supply services more generally than goods then
click this check box to de-select it.
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Setting up Department Labels
In the last chapter the section headed Departmental Reporting explains how you can refine your accounts structure
in order to build in a means to identify the financial performance of particular sections of your business — depart-
ments.

This departmental reporting facility relies on identifying those accounts, totals and headings which are associated
with particular departments by means of labels.

This is how you create a set of labels…

Click on the General Ledger Icon in the Bot-
tom Line Desktop so that the General Menu
appears

Choose Edit Departments from the General
Menu to reveal this dialogue…

Type the name
of your first
department in
the text box… … then

click New.

Add each additional label in the
same way then Click OK.

You can make changes to your set of labels like this…
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Order among labels

The order that you list the labels may help
you to locate them more easily.  To change

the order of labels once you have entered them, do
this…

Changing labels

To change the name of a label…

Click on the label that you
wish to change…

…then type the new
name in the text box… …and click Change.

Click the label that you
want to move…

… then click the required
direction.

 means to the top and

 means to the bottom of the list.
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Saving Your Work
Before going any further, it is worth noting how to save a permanent copy of your work.  The File menu includes
three options for saving your work…

BACKING UP ACCOUNTS

Save a Copy: Choose the Save a Copy
option when you wish to continue working
with the current document while creating a
security copy of its contents under a different
name.  We recommend that you use this
opton for preparing backups of your data.

When you choose this option the file directory
dialog box appends the current date to the
existing document name.  If you retain these
invented names you can build up a set of
archives which can be readily identified by
their chronological order.  You are, of course,
free to modify the preset name if required.

Once saved, the current document remains
as the active desktop while the duplicate
copy is set aside under its new name.

Save As: Choose the Save As
option to create a new document
containing any revised information
— while leaving the original ver-
sion unchanged. Once this is
done, the new document appears
as the active desktop while the
original document is left, un-
changed.

Save:  Choose the Save option to
save the changes you have made
to the open document — in other
words, it replaces the original
version.

When you choose Save As or Save a Copy, the file directory dialog appears which allows
you to decide where the file should be stored.  This dialog is explained overleaf…
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Taking precautions!

As when using any computer applica-
tion, we strongly advise that you save

your accounts information frequently and on a
regular basis.

It is also a wise precaution to make regular
security copies — or backups — onto removable
disks or cartridges which can then be stored
away from the original computer.  Hard disks are
not immune to the odd catastrophe — such as
data corruption or simply refusing to start up —
and time invested in making security copies is
infinitely preferable to time wasted in repeating
lost work.

Before closing each accounting period, you
should also back up the accounts document as a
means of archiving information.  Once archived,
this information can then be retrieved whenever
needed — for example, to print a set of reports.

If you are unsure about backing up, turn to your
Macintosh User’s Guide for more information.

The Current Directory
Name.  Use the pop-up
menu to move to a higher
level folder or disk.

Double click a lower level
folder to open it and list
its contents in the current
directory.

Type a name or modify the
suggested name for the new
document.

Click here to create an ac-
counts template.  Refer to a
later chapter on templates.

The name
of the

Current
Disk .

Click to create a new
folder in the current
directory.

Click to save the
document to the
current directory.

Saving your Work (continued)
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OR,

Click the close box on the Bottom Line desktop.
Closing a Bottom Line document

If you have finished working on your accounts docu-
ment, you can close the document along with all open
windows…

EITHER,

Choose Close from the File
menu.

If the document con-
tains un-saved
changes, you will see
this dialog…

Click Don’t Save to
close the file without
saving the changes.

OR, click Cancel to
return to the window.

OR, click here to save the changes
and close the document.
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Throwing away all your changes!
Although it is not recommended to throw anything
away during an accounts session, there may be times
when you have been making changes or adjustments
and decide to approach them from another direction —
returning to the file that as it was last saved.

EITHER: Close the file
and click the Dont Save
button as described on the
previous page.  Then use
Open from the file menu to
re-open the last saved
version.

OR: Choose Revert to Saved from the File menu.

This warning appears…

Click OK to proceed.
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Opening an existing Bottom Line Document
Having closed the current document, you can open another set of Bottom Line accounts in one of two ways…

EITHER, from the Macintosh desktop:

Locate then double click the icon
which represents the Bottom Line
accounts that you want to open.

OR, from within Bottom Line:

From the Bottom Line
menu bar, choose Open
from the File menu to
display the directory list…

Use the directory list to
locate and open the

required Bottom Line
document in the usual

Macintosh way.

If you entered a password when you created your
accounts Bottom Line will require you to enter that
password…

Enter your password -
remembering to use the
exact characters and
whether letters are capi-
tals or lower case.

Click OK to display the
Bottom Line Desktop.
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Crash recovery…

As explained earlier, it is important that you save your work regularly.  However, if you have a set of
accounts open and your Macintosh runs into trouble, Bottom Line creates a temporary set of files to

protect any changes you have not managed to save.  To retrieve this data…

Re-start your Macintosh if necessary then open Bottom Line in the usual way.  You now see this dialog…

Click Remove to delete the temporary files containing the
un-saved changes.  Bottom Line seeks confirmation
before proceeding.

Choose Quit to close the Bottom Line application alto-
gether.

Clicking the Open button prompts Bottom Line to open
the temporary data set containing the unsaved changes.
This information appears as an ‘Untitled’ document —
you can then check the rescued data and, if satisfactory, save it under a name of your choosing.

Leaving Bottom Line
If you have finished working with Bottom Line alto-
gether, choose Quit  from the File menu to leave the
application.
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